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General Education Component 

B. Voc. Semester V                                                           COURSE: S.BVS.5.01/BVT.5.01 

         

ELEMENTS OF DIGITAL DESIGN 

 

Learning Objective: Learn to explore the beauty of digital design software from the 

practical to the painterly artistic. In 45 sessions, practice the editing concepts to understand 

how Photoshop will help to create successful customized images. 

 

Number of lectures: 45 

 

Unit 1 - Getting started with Photoshop                        Number of lectures 10 

 

 Fundamentals of Photos editing softwares 

 What new in photoshop 

 Basics of Images 

 Vector Images 

 Bitmap Images 

 Interfacing with the Photoshop Desktop 

 Working with The Menu Bar and Tool Box 

 File and Edit Menus 

 The Image Menu 

 The Layer Menu 

 The Select Menu 

 The Filter Menu 

 The View Menu 

 The Help Menu 

 ToolBox 

 New Features in Photoshop 

 Custom Brushes 

 Healing Brush 

 Picture Package 

 Web Photo Gallery 

 Spell Checking 

 Opening Recent Images 

 Importing Images 

 PDF Image 



 

 Annotations 

 WIA Support 

 Placing Images 

 Optimizing Images 

 File Browser 

 PDF Security 

 Understanding the Selecting Tools 

 Rectangular Marquee 

 Move Tool 

 Lasso Tool 

 Magic Wand 

 Painting and Drawing Tools 

 Editing and Retouching Tools 

 Background Eraser (E) 

 Erasing Image Background Color 

 Guides, Grid and Slices 

 Transform 

 Layers 

 Effects 

 Filters 

 Using the Color Tools 

 Working with Palettes 

 Actions palette 

 History Palette 

 Swatches Palette 

 Brushes Palette 

  

Unit 2 - Painting & drawing Tools                                Number of lectures 8 

 

Using The Brush and Pencil Tool 

 Choosing a Brush Size 

 Picking a Painting or Drawing Mode 

 Setting Opacity And Flow 

 Using Airbrush Mode 

 Blending with the Smudge Tool 

 Loading Brush Sets 

 Working With The Brushes Palette 

 Renaming Brush Presets 

 Deleting Brush Presets 

 Working with the Healing Brush 

 Patching Images 

  

Unit 3 - Color Management in Photoshop                              Number of lectures 9 



 

    Applying Colors to your Image 

 Using the Color Picker 

 Selecting Colors with the Eyedropper Tool 

 Working with Color Channels 

 Displaying and Hiding Channels 

 Mixing Color Channels 

 Working with the Color Table 

 Using Auto Color 

 Using Special Color Effects 

 Inverting Colors 

 Working with Color Thresholds 

 Equalizing Colors 

 Posterizing Images 

 Creating a Gradient Map 

 Desaturated Colors 

  

Unit 4 - Working with Layers Session 27:                    Number of lectures 7 

 Layer concepts 

   Creating New Layers 

 Activating a Layer 

 Duplicating Layers 

 Arranging Layers 

 Working with Layer Locks 

 Deleting Layers 

Creating Layer Based Slice 

 

Unit 5 - Using fills & styles Session 31:                               Number of lectures 11 

 

 Using the Pattern Stamp Tool 

 

 Applying Pattern Fills 

 Working with Styles Palette 

 Understanding the Gradient Tool 

 Customizing a Gradient 

 Applying a Gradient 

 Working with the Pattern Maker 

 Creating your Own Patterns 



 Working with the Layer Style Dialog Box 

 Customizing Blending Options 

 Drop Shadow 

 Inner Shadow 

 Outer Glow 

 Inner Glow 

 Bevel and Emboss 

 

Continuous Internal Assessment 

Assignments / Project 

Mid Term test. 

 

List of Text Books: 

 

 Photoshop(R) 7: The Complete Reference 

by Laurie Ann Ulrich (Author) 

 

   Photoshop CC: 

by Lesa Snider (Author) 

 

 

List of Practicals: 

  

Experiment 1. Moving objects from one layer to another using layer properties. 

Experiment 2:Painting objects with Gradient and enhancing colour values 

Experiment 3. Applying black and white ecffect to perticular object in image. 

Experiment 4. Applying motion filter effect. 

Experiment 5:Implementation Lens flare, colour lense & light reflection 

Experiment 6.Applying dispersion effect. 

Experiment 7. Implementation of water illusion effect. 

http://www.amazon.com/s/ref%3Ddp_byline_sr_book_1?ie=UTF8&amp;text=Laurie%2BAnn%2BUlrich&amp;search-alias=books&amp;field-author=Laurie%2BAnn%2BUlrich&amp;sort=relevancerank
http://www.amazon.com/Lesa-Snider/e/B00376ZIHO/ref%3Ddp_byline_cont_book_1


Experiment 8.Creating Gallery  

T. Y. B.VOC                                                                                  COURSE:  BVS/BVT 5.02 

 

Title: ENTREPRENEURSHIP (Part I) 

 

Learning Objectives: 

To equip students with knowledge of creating, establishing, managing, developing or pruning 

enterprises, either of their own or to understand enterprises that they will be dealing.  

 

Total Lectures: 60     

 

UNIT 1: The Entrepreneurial Evolution                                                        20 lectures 

• Nature & Development of Entrepreneurship. 

• The Entrepreneurial Decision Process. 

• Venturing- New Venture Formation. 

• Types of Enterprises. 

• Role of Entrepreneurship. 

• The Entrepreneurial & Intrapreneurial Debate. 

• Identifying & Evaluating Opportunity for Enterprise Development. 

• Resource requirement to set-up & start-up & operate Enterprise. 

• Strategic/Tactical/Operational orientation of establishing Enterprise. 

• Management Structure. 

• Entrepreneurial background & characteristics. 

• Role modeling of successful entrepreneurs.  

• Cross border Entrepreneurship. 

• Case Studies. 

 

UNIT 2: Creativity in Enterprise                                                                                20 

lectures 

• Idea Generation. 

• Creative Problem Solving. 

• Product Identification & Development. 

• Technology in Enterprise establishment. 

• Enterprise as a multi-dimensional enitity. 

• The Business Plan. 

• The Functional Plan. 

 

 

 

UNIT 3: Start-up establishment of Enterprise                                                           20 

lectures  

• Sources of Funding. 



• Venture Capital. 

• Risk evaluation of Enterprise. 

• Enterprise valuation.  

• Leading and Managing the Enterprise.  

• Growth Strategies. 

• Exiting the Enterprise. 

• Ending the Enterprise. 

 

Evaluation:  

• CIA 1 (20 marks): Class Test 

• CIA 2 (20 marks): Project/Assignments 

• End Term Exam: 60 marks (Written exam)  

 

TEXT BOOKS:  

• Entrepreneurship – 6th Edition. Robert D Hisrich, Michael P Peters, Dean A 

Shepherd.McGraw-Hill. 

• Entrepreneurship – David Stokes, Nick Wilson, Martha Mador.South-Western Cencage 

Learning. 

 

REFERENCES: 

• The Oxford Handbook of Entrepreneurship – Mark Casson, Bernard Yeung, Anuradha 

Basu, Nigel Wadeson.  Oxford University Press. 

• Entrepreneurship in India. Dr Sanjay Tiwari, DrAnshujaTiwari. Sarup& Sons. 

• Entrepreneurship Development in India.  Sami Uddin. Mittal Publications. 

• Dynamics of Entrepreneurial Development & Management - Vasant Desai. Himalaya 

Publishing House. 

• Patterns of Entrepreneurship Management. 3rd Edition. Jack M Kaplan, Anthony C 

Warren. John Willey & Sons Inc.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



T. Y. B.VOC                                                                                                         BVS/BVT  

5.03  

Title: PSYCHOLOGY 

Learning Objectives: 

• To enhance the thinking, emotions, communication and interpersonal skills of students so 

that they can be good at customer handling and services.  

• Enable them to maintain a healthy work-life balance. 

 

Total Lectures: 60 

 

Unit 1: Understanding the Self                                                                             15 lectures 

• Self esteem and Subjective well being 

• Positive Thinking and Optimism 

• Creative Thinking, Problem Solving and Decision Making 

• Goal setting and Time management 

• Motivation 

• Emotional intelligence 

 

Unit 2: Working with others                                                                                  15 lectures 

• Communication (Verbal and Non Verbal) 

• Empathy and Listening skills 

• Giving and receiving Feedback 

• Conflict Management 

• Team Building and Team work 

 

Unit  3: Customer Satisfaction                                                                              15 lectures 

• Psychology of customer service: Creating and sustaining customer relationships 

• Product knowledge 

• Sales and its relation with customer satisfaction 

• Handling complaints 

 

Unit  4: Balancing work and life                                                                           15 lectures 

• Work Life Conflict 

• Impression Management 

• Job satisfaction and Employee satisfaction 

• Stress Management 

Evaluation:  

• CIA 1 (20 marks): Class Test 

• CIA 2 (20 marks): Assignments 

• End Term Exam: 60 marks (Written exam based on case study analysis)  

References 



Feldman.R.,(2016), Understanding Psychology ,Tenth Edition, McGraw Hill Education 

Pvt.Ltd, India. 

Kumar.V., (2008), General Psychology, Himalaya Publishing House ,India. 

Weiten.W., Hammer.E.& Dunn.D.,(2009), Psychology and Contemporary Life: Human 

Adjustment,Wadsworth,Cenagage Learning,USA. 
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B.Voc (Software Development) Semester V                                              Course: S.BVS.5.04 

 

 

                                               ADVANCED ANDROID PROGRAMMING                               

 

Learning Objective:   To master the Android developement  using Advanced programing 

features using,XML,Hypertext and scriting and desktop language.                                                                                                                      

                       

[Total Lectures 60] 

                 

 

UNIT 1: Android Device Integration                                                                            [7] 

  

CameraApp, Camera Recording, Bluetooth,WIFI, Contacts,Audio Capture, 

Theme/style.Thread. 

 

UNIT 2:CustomeGesture                                                                                               [7] 

 

CommonGesture, TouchEvent, MotionEvent, PinchExample, ClipBaord, 

ImplicitIntent,TransitionDemo, NewDrawer Demo, Scene Transition 

 

UNIT 3:Android API using HTML & script                                                              [6] 

 

Online Website, Offline website, Android event with Javascript, 

WebViewClient/WebChromeClient, File reading, Fragment Example 

 

UNIT 4: Database, fonts & Explicit events                                                                [15] 

 



SQlite Database, MaterDetailsFlow, Contact list database, Custom font, ClipBaord, 

CardDemo,  

Card Demo, AppBar, FabExample, ExplicitEvent, CustomePrintDatabase, StorageDemo 

 

UNIT 5:Location Based Services                                                                                 [15] 

 

Network Connectivity, GPS, Google Map, Permission Manager, Local Bound, Remote 

Bound, Send Broadcast, Broadcast receiver 

 

 

Continuous Internal Assessment 

Assignments / Project 

Mid Term test. 

 

List of Text Books: 

1. Android Design Pattern:Interaction Design Solution for Developers.(By: Greg Nudelman ) 

2. Programming Android-(By: Zigurd Mednieks, Laird Dornin, G. Blake Meike & Masumi 

Nakamura ) 

  



B. Voc. (Software Development) Semester – V                               COURSE : S.BVS.5.05 

 

ASP.NET 

 

LEARNING OBJECTIVE: 

To equip the students with skills required in software industry. 

Students will learn the latest of ASP.NET in framework 4.x/5.x. 

Students can apply the skill learnt in developing website or application. 

 

 [Total Lectures 60] 

 

Unit 1.   Introduction, Controls, Event and web service    [20] 

Introduction: 

- Understanding Visual studio IDE environment 
1) Design view 
2) Source view 
3) Output window 
4) Error list window 
5) Intellisense 
6) Property window 
7) Object Browser window 
8) Start page 
9) Toolbar and Toolbox 
 

- ASP.NET life cycle. 
- Common Language Runtime (CLR) architecture. 
- Using .NET Framework Class Library. 

 

Different Controls:  Introduction to control class, TextBox control,  

Button Control, Label Control, Image control,  ImageButton control , 

 ImageMap control, DropDownList control, CheckBox control, RadioButton  control, 

Table control, Calendar control,  SiteMap control , TreeView control ,  Menu control,  Validation  

controls, Login controls, Database controls. 



Windows Presentation Foundation (WPF). 

 

Event handling: Application_Start, Application_End, Page_Load , Page_Unload, Click event 

:OnClick , TextChanged event: OnTextChanged , Command event: OnCommand , 

CheckedChanged event: OnCheckedChanged , SelectedIndexChanged event: 

OnSelectedIndexChanged, postback events 

Using event argument etc. 

Web service: What is a web service? SOAP and Web service. Creating web service, 

consuming web service. 

 

Unit 2.    Validation, Navigation, and Ajax in ASP.NET     [20] 

 

Validation Control: Introduction, basic validation controls, validation techniques, using 

advanced validation controls like: 

Regular Expression Validator Control, Compare Field Validator Control 

Range Validator Control,Validation Summary Control, Custom Validator Control 

State Management: Using view state, using session state, using application state, using 

cookies and URL encoding.  

Master Pages: Creating master pages, content pages, nesting master pages, accessing 

master page controls from a content page.  

Navigation: Understanding Site Maps, Using the Sitemap Path Control, Formatting the 

Sitemap Path Control, Using the Menu Control, Using Tree View Control. 

Ajax: Introducing AJAX, Working of AJAX, Using ASP.NET AJAX server controls. 

 

Unit 3.   Database with ADO.NET, LINQ and Crystal Report    [20] 

Database Elements:  

1) ADO.NET Object model  
2) Data Binding 
3) Using Connection, Command,  
4) DataReader classes, Queries returning result sets 
5) Passing parameters in queries 
6) Using Repeater control 
7) Data Adapter, Using Data Set (Typed), Data Table, Data Row & Data Column 
8)  Introducing the ADO.NET Entity Framework. 



9) Mapping Your Data Model to an Object Model  
10) CRUD with ASP.NET 
11)  Authentication and Authorization with ASP.NET    
 

 LINQ: 

1) Introducing LINQ and its Architecture 
2)  LINQ to Objects  
3)  LINQ to XML  
4)  LINQ to ADO.NET  
 

Crystal Report: 

  1) Adding a Crystal Report to an ASP.NET Application  

2)  Inserting Fields, Text, and Special Fields  
3)  Sorting, Grouping, and Subtotaling  
4)  Using Select Expert  
5)  Dynamic Formatting  
6)  Using the Crystal Reports Viewer 

 

Continuous Internal Assessment 

Assignment on unit 1, unit 2, unit 3  

Mid Term Test. 

BOOKS: 

1) ASP.NET  4.0 in simple steps dreamtech press 
2) Murach’s ASP.NET 4 Web Programming with C# 2010, 4th Edition, Anne Boehm, Joel 

Murach, SPD. 
3) Integrating Crystal Reports into an ASP.NET Application 

By Vincent Varallo Wrox Publication 

 

REFERENCES: 

 

1) ASP.NET – The Complete Reference Tata McGraw Hill. 
2) Beginning ASP.NET 4: in C# and VB by Imar Spaanjaars  Wrox  Publication. 
3) C# and .NET 4 by Christian wrox publication. 

 

RESOURCE: 

http://www.tutorialspoint.com/asp.net  



B. VOC (Software Development) SEMESTER V                                                 BVS.5.PROJ 

PROJECT- I 

[Total Lectures 180] 

Project will carry 6 credits with 200 Marks. 

Students can do live project in industry or in-house project. 

Students are expected to give time equivalent to 12 lecture periods/week, out of which 3 periods 

will be contact time for guidance from internal guide. There will be continuous internal 

assessment (CIA) for 40% of the credit (80Marks).  

This will consist of: 

CIA 1 assessment of synopsis and viva on it 

CIA 2 analysis of requirement gathering, system design including DFD, 

             Use case, ER, Normalization, Context level diagrams etc. 

Remaining 60% of the credit (120Marks) will be end semester examination consisting of 

documentation, presentation   and viva. This will be jointly examined by the project guide 

and external examiner under the subheading of marks as follows: 

Documentation Presentation 

(validation, database 

handling) 

viva Execution of  

various modules 

with report and 

testing 

System design 

understanding 

30 30 20 30 10 

 

 

List of project categories 

1) Hardware projects based on microcontroller / PIC 

2) Networking  projects 

3) Mobile  projects 

4) Wireless technologies 

5) Website projects 

6) Desktop application 

7) Real-time application in Linux/ Unix 

8) Or  any other suitable project which is approved by the project guide 

 

 

 



       

 

 

Suggested format for project report S.BVS.6.PROJ 

 

1) Cover page 

2) Certificate from college(for in-house / external project) 

3) Synopsis of project 

4) Project report 

a) Table  of  content 

b) Definition  of  problem 

c) Objective  and scope  of  project 

d) System analysis  and design 

i) User  requirement 

▪ Functional  requirement 

▪ Non-functional  requirement 

ii) Normalization  

iii) DFD , context level diagrams 

iv) Flowchart, ER  diagram 

v) Use  case  diagrams 

e) Feasibility study 

i) Technical feasibility 

ii) Economical feasibility 

iii) Operational feasibility 

f) Software  engineering paradigm applied 

g) Software  and  hardware  requirement specification 

h) PERT  chart, Gantt chart 

i) Coding 

j) Code  efficiency 

k) Validation  checks 

l) Testing  

• Test techniques(white box and black box testing) 

• Writing Test cases 

• Using  test data 

• Generating  defect reports 

• Use  of  testing tools(manual/automated) 

m) System security measures 

n) Cost  estimation of  project 

o) Reports  

p) Screen shots   

q) Future  enhancement 

r) Bibliography 

s) Glossary 

5) Students  have to submit  black book to  college(1 per group) in A4 size  with one side  

written (approx 150-200 pages) along with CD having full documentation and codes 

 

6) Students doing project in industry will have to get certificate from the company. 

 



B.VOC (Software Development) SEMESTER V                                                    BVS.5.PR 

 

ANDROID Practical List: 

 

Learning Objective:  

To introduce the concept android programming and develope app using android development 

studio. 

 

 

List of Practicals: 

  

Experiment 1.Android Camera App(Customized preview) 

Experiment 2: Android Voice Recording App 

Experiment 3. Video Recording app  

Experiment 4: Common Gestures 

Experiment 5: Android Text to speech 

Experiment 6.Bluetooths scanner App/Barcode Reader 

Experiment 7.WI-FI Scanner & pairing  

Experiment 8.Sqlite Database to add,find &delete(Contact List) etc   

 

 

ASP.NET PRACTICALS 

 

LEARNING OBJECTIVE: 

To equip the students with skills required in software industry. Students will learn the latest of 

ASP.NET in framework 4.0/4.x. Students can apply the skill learnt in developing website or 

application with practice from practical. 

 

Attempt any 8 practical’s from the list. 

 

Practical No 1:  



Create a simple Web Service that converts the temperature from Fahrenheit to Celsius, and vice 

versa create a simple Web Service that converts the temperature from Fahrenheit to Celsius, and 

vice versa. Also write an ASP program to consume this web service. 

 

Practical No 2:  

Design a UI and use validator for following conditions 

· A password which is entered twice for confirmation 

· The age of the user to be over 21 

· The date to be after the 10/10/2000 

 

Practical No 3:  

Design a Login screen in ASP.NET  which accepts user name and password. On submit it  should 

check  from the server whether the user exists or not . If the user exists in web server  then he/she 

should be directed to proper  web page with  welcome message. 

 

Practical No 4:  

Write the following application. 

The initial page is called Validator.aspx and it has 7 text boxes representing  

(Name, Family Name, Address,City, Zip Code, Phone and e-mail address) 

 and a Check button. 

User gets the following page after clicking on Check button: 



 

 

 

The required validation actions are: 

•name different from family name, 

•address at least 2 letters, 

•city at least 2 letters, 

•zip-code 5 digits, 

•phone according to the format XX-XXXXXXX or XXX-XXXXXXX, 



•e-mail is a valid email. 

 

After entering some of the details correctly user gets the following message: 

 

 

 

And after a correct submission of all the details: 

 



 

 

 

Practical No 5:  

Create  a screen  which  accepts  student rollno . On click of submit it should display student result in 

the gridview with fields 

 

Name  Course Marks  TotalMarks Percentage 

 

The database table contains table called  student( rollno, name, course , address, year) 

Result(rollno,subject,marks, totalmarks) 

 

 

Practical No 6:  

 

Using  crystal report  design simple marksheet  for  SSC  result.  The data should appear dynamically 

form database. 

 



Practical No 7:  

Design UI for credit card data entry. User writes all the details such as card no(16 digits) expiry date 

CVV no etc. These details should be validated using validators and database for appropriate fields. 

After verification it asks for amount of transaction with password. If amount < balance display 

insufficient balance else display page which tells transactions successful. 

 

 Practical No 8:  

Create a Web application that illustrates the use of themes and master pages with Site-Map. And 

create a web page with CSS. 

 

Practical No 9: 

Write a Program in ASP that has a form taking the users name as input. Store this name in a 

permanent cookie & whenever the page is opened again, then value of the name field should be 

attached with the cookie‟s content. 

 

Practical No 10: 

Demonstrate user’s Authentication and Authorization in ASP.NET 

 

Practical No 11: 

Demonstrate the use ad-rotator to change advertisements on client side request. 

 

Practical No 12: 

Create a small online quiz application which displays the set of questions (differently to different 

users) based on the authentication and subject selection. At the end it displays the marks scored by 

candidate. Also it doesn’t allow any page view without authentication (use session concept).  

 

 

 

Practical No 13: 

Create a registration form for students and demonstrate CRUD operation on it in ASP.NET. 

 



Practical No 14: 

Demonstrate use of System.Collections.Generic to store the details of students with Id, Name, 

Course, and D.O.B etc. Now store these details in database using Collection. Add search feature 

which searches record as per id.  

 

Practical No 15: 

Create a web application to insert 3 records inside the SQL database table having following fields ( 

DeptId, DeptName, EmpName, Salary). Update the salary for any one employee and increment it to 

15% of the present salary. Perform delete operation on 1 row of the database table. 

 

Continuous Internal Assessment 

Conducting practical test 
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